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Abstract

ReadyToShip is a windows application aimed at helping the Seapine employee that
moderates Seapine’s beta sites to better track interactions with testers. Seapine Software
is the leading provider of quality-centric application lifecycle management (ALM)
solutions for product development and IT organizations. The application is written in C#
using Microsoft Visual Studio 2005 and it uses Microsoft SQL 2005 Server to store its
database. The application helps the employee track of all tester interaction trough
incidents. The application can import beta site tester defects and feature requests posted
on the beta site web page as well as e-mails sent to a POP3 mail account. The application
takes these various tester contacts and converts them to incidents. Incidents can also be
manually created, to account for those incidents that may originate through a phone call.
The application also provides some basic reporting tools to get some metrics on the
information gathered from the testers.



ReadyToShip

Introduction
Seapine software is “a global provider of innovative application lifecycle
management (ALM) solutions that manage process, change, and quality in product

development and IT organizations.” (11) Some of Seapine’s product brands include:

- QA Wizard - Automated functional and regression testing.
- Surround SCM - Software configuration management.
- TestTrack Pro - Issue and development process management.

- TestTrack TCM - Test case planning and tracking.

In the fall of 2006 Seapine launched for the first time TestTrack TCM, and also
released two new major upgrades for TestTrack Pro (7.6) and Surround SCM (5.0). A
beta program was created for these three releases, and a new approach was taken in
managing the beta site for these products. The previous approach was to contact certain
customers to recruit as beta testers. The testers would agree to test the beta software and
would send some feedback on the product. The problem with the old approach is that the

beta testers were few and the feedback provided by them was even less (9).

For this beta program, Seapine instead launched a Web site to manage the beta
sites and incorporated it to its new Web site, labs.seapine.com. Seapine sent an e-mail to
all of its customers, and made an announcement on the CM Crossroads website to invite

anybody to sign up and join the beta program. According to Rick Riccetti, Seapine’s



CEO and founder, this site was created to increase beta site members and also give users
more ways to give Seapine valuable feedback(9). Some of the features of this site were
the ability to download the latest beta release candidate, access to user forums to discuss
defects, feature requests and best practices and the ability to enter a request for a feature,
and to report a defect. Figure 1 below displays a similar page found on Seapine’s web
site to the one used on the beta program web site where users can report an issue with any

product.

£ Seapine Software S

SOLUTIONS  PRODUCTS  SERVICES SUPPORT  PARTNERS  NEWS & EVENTS

Report an Issue

Upgrades Pleass complste the fallowing form to repart 8 bug or other issue in Ssapine products,

Issue Information

* Indicates required information

Product:* I— Please select - b3
wersion: 1

Operating System: I— Please select - =
Serial Number: 1

Issue Description *

Contact Information

Name:* L 1
Company:* ]
Email:* 1
Phone: L 1

Figure 1 — Report an Issue Page on Seapine’s website



1. Problem Description

The information gathered from the beta program web site was not being stored in
one single place. The list of users that register were being stored in a MySQL database,
and the feature requests and defects were automatically imported to a TestTrack Pro
database. Also, some beta users were still sending e-mails to the support inbox and call
the support department. E-mails that came to the support inbox create a case in Seapine’s
Customer Relationship Management (CRM) tool. Under this scenario there are three
different places where information relevant to the beta members was being stored. Figure

2 below illustrates this current scenario.

TestTrack Pro

Beta Site Manager

&
L4

Figure 2 — Current Scenario

The purpose of every beta program is to get outside validation to build
confidence, determine product readiness to ship, early learning and feedback,
testimonials, quotes and success stories and to build ongoing relationships with a friendly
set of customers (5). A Beta program is one of the most critical factors in the success or

failure of a product (6).



Since the data was being stored in three different places, it was very difficult for
the Seapine employee in charge of managing the beta tester feedback to track the various
feedback submitted by the testers. The minimum number of serious testers in an
exclusive beta program is about 100 (12), and the lack of a unified interface and database
makes it difficult to be able to identify users that Seapine may want to contact for more
exclusive beta programs. An exclusive beta program is something that Seapine is

considering for the next beta release for any of its products.

The setup inhibited the ability to see the big picture and be able to determine the
state of the product (8). Without a reliable way to view all information submitted by beta
site members, it was difficult to be able to accurately get useful data from the beta testers.
If a company does not understand the needs of its customers, how can it possibly deliver

a product? (3)

2. Solution Description

A tool that integrates and brings together all data coming from these different
sources into one database and one interface solves this problem. This tool imports the
data from all sources, filters it and saves it to a Microsoft SQL 2005 database. This tool
offers a simple to use interface that a beta program manager is be able to use to extract

accurate information from the beta program.

This tool is called ReadyToShip and is similar to a light weight CRM tool that

allows the beta program manager to manage all beta site tester feedback, and be able to



easily retrieve their e-mails submitted, phone calls, as well as defects and feature requests

submitted via the site. Figure 3 illustrates the proposed scenario that the tool delivers.

¥—— | ReadyToShip _ * (TestTrack Pro

Beta Site Manager

Figure 3 — Proposed Solution

2.1 User Profiles
In order to minimize a learning curve, user profiles are managed by security
groups as it is done with Seapine products. There are three security groups that have

access. All intended users have a medium to high IT literacy.

2.1.1 Administrator
This user has full permissions and is in charge of installing the application, sets

which users have access, and establishes the SQL server database to be used.



2.1.2 Project Manager

This is the beta site manager and has full permissions within the scope of a
project. This user is able to set up connections to the TestTrack and MySQL databases
for importing information as well as all other project options. This security group
contains most users. Beta sites are usually managed by a single member of the Technical

Support team. These employees have a high level of IT literacy.

2.1.3 User
This is equivalent to a “guest” user account. This account mainly has read only
permissions and is to be used only by individuals who may want to review feedback from

testers. A likely candidate for this type of user would be a product manager.

2.2 Design Protocol
2.2.1 Application Structure

The tool consists of two applications. One application is RTS Admin and is used
to manage the application on a global scope. This application is used to manage users
that have access to the application (Beta Site Managers) and the SQL Server connection
information. Projects are created using this application by providing information
required to connect to the designated SQL Server and create the database. This
application is used by the System Administrator, and has to be a member of the

“Administrator” security group in the application in order to be able to access it.



The other application is the “ReadyToShip” client. This is the application that
most users use. This is the application that actually is used to manage the incidents.

Incidents are any phone calls, e-mails, or web site posts from the testers.

2.2.2 Database Structure

There are two databases. One is be the back end database for the admin tool,
RTA Admin. The other database stores the actual project, including beta site user list and
incidents using the ReadyToShip client. Figure 4 below represents the database for the

RTS Admin application.

tbl_Users * = tbl_Project_Users *
_%‘I User_ID _?I D rec

) ser e | Project o

_I User_Passwd _I User_ID

_I Group_ID

: ﬁ

tbl_Groups * thl_Projects *

_@' Group_ID 7| Froject_ID

_I Group_Mame _I Project_Mame

_I Group_Description _I Project_Descripkion

ReadyToShip Client.

!

tbl_Project_Connection *

%‘I Caonnection_ID
I Project_ID
I Project_Server

I Project_Daktabase

_I User_Mame

I User_Password

Figure 4 —

RTS Admin database

Figure 5, located on the next page, shows the database structure for the




N

S0l _User_Name
S0L_Passwaord
TIP Praject

tbl_TTP thl_SMFConn
Connection_ID ﬂ connlD
SGL_server | s
TTPDB | msawoe

| mvsousertiame
J mySQLPassword

=

bl_Incident_Source *

i

Source_ID
Source_Mame

Source_Description

=
=2

|_IncidentHistory *

L =

hist_ID

inc_ID
Event_Type
Event_Description
Event_Date

Event_User

Figure 5 — ReadyToShip Client database

thl_MailOptns

_ | ieer

SMTP_Hast

J SMITP_User_Hame:
SMTP_Password
SMTP_Return_Address

| Pops Hast
POP3_fccount

J POP3_Password

tbl_IncidentEmail *

tbl_Incident *

j Incident_ID
J Summary
J Description
J Tester_ID
J Version

|| souc= 0

J Date_Created

| stans

| ker
| meident 10

thl_Emails *

tbl_EmailUID *

=

| ke
| Email_um

tbl_Defect_ID

] ivRerord

J Defect_Record_ID

2.2.3 Graphics and Visual Style

To ease the learning curve for Seapine employees, ReadyToShip uses the same

graphics for its buttons as the Seapine products. The applications themselves are

tbl_Tester *

idRec

Email_Subject
Email_Body
Email_Source
Parsed_Email_Source
Email_Type
Email_Date
Email_Number

Email_Destination

4 Tester
J DisplayHame

J EmailAddress

designed using Seapine’s TestTrack Studio as a model. The colors used in the

application are the standard windows application foreground and background colors.

2.2.4 Application Design and Navigation
The applications’ design and navigation are consistent with Seapine’s TestTrack
Studio application. Both applications consist of a Multi Document Interface (MDI)

window. The applications show data in list windows. All functions are available through

menu options, and the most used functions also have buttons on the toolbar.




2.3 Other Options

There are few software packages in the market that are able to deliver this
solution. However, these software packages can not import data from TestTrack Pro
unless professional services are purchased or if it is customized by the software provider.
One of the solutions in the market is from Centercode Solutions and the tool is called
Centercode Connect. This is a web based interface and it is hosted by Centercode
Solutions. The cost per project is $3,000 (1). Creating a custom-built tool ensures that
all of the needs are met and since all tools needed to create this solution are already

owned by Seapine, the cost was non-existing.

3. Deliverables

There are several functions that ReadyToShip and RTS Admin provide.

3.1 RTSAdmin

System administrators setup users to have access, create projects and determine
the SQL server to be used. The administrator must use an SQL user account that has
enough security permissions to create a database. This user account is used for all

communications between the ReadyToShip client and its database.

3.2  ReadyToShip

The user tracks and manages all beta user interaction with the ReadyToShip
client. ReadyToShip manages beta tester communications with incidents. An incident is
a communication between a beta tester and Seapine. The application consists of

modules, each specialized for each functionality to track these incidents.



3.2.1 TestTrack Import

ReadyToShip imports defects and feature requests submitted by beta testers.
These are entered in the web pages and are automatically imported into the TestTrack
database, which is stored in Microsoft SQL. The application accounts for previously
imported records and only imports those records that are new. The application also
accounts for the beta tester not existing in the ReadyToShip project database. When
importing new records, it checks to see if the tester exists or not. If the tester is not

found, the tester is added.

3.2.2 Simple Machine Software Import

ReadyToShip imports the list of registered testers from the MySQL database that
the user forum software, Simple Machine Software (SMS), uses to store its information.
The application accounts for previously imported testers and subsequent imports only

import new testers.

3.2.3 E-mail Import

ReadyToShip imports e-mails from a designated POP3 account. Each e-mail
object is saved to the ReadyToShip project database. The e-mails in the POP3 account
are only read. Once the e-mail is imported into the database, the user can then delete e-
mails, create an incident from an e-mail, or link an e-mail with an existing incident. This
import accounts for previously imported e-mails. Any e-mails already imported are not

re-imported even if they are deleted from the ReadyToShip project database. The import

10



module also accounts for a tester that may have sent an e-mail but does not exist in the

database. If the e-mail is address is not found, a tester is created.

3.2.4 Manual Incident Creation
ReadyToShip gives the user the ability to also enter new incidents manually.
These are for those incidents that originate by a non import method. The most likely

scenario is when a beta tester calls Seapine to report an issue.

3.2.5 Send Mail Capabilities
ReadyToShip is able to act like a mail client and connect to a Simple Mail
Transfer Protocol (SMTP) server to send e-mails. This allows for the user to reply,

forward and send e-mails to testers. ReadyToShip keeps a track of the e-mail and if the

reply is to an e-mail that is associated with an incident, it links the reply to this incident.

This allows the user to keep track of all e-mails associated with the incident.

3.2.6 Project Administration Tools

The user has the ability to specify a POP3 account to import e-mails from and is

able to specify an SMTP mail server to deliver e-mails. The administrator is also able to

specify the TestTrack and SMF databases to import data from.

11



4, Design and Development

41  Budget

The project did not incur any costs. All applications used for the development of

this tool were already owned by Seapine and the project did not require a dedicated

computer or special hardware. Figure 6 below displays how much money this project

would cost if Seapine did not have any of the components mentioned above (Total Retail

Cost).
Seapine Student
Iltem Description Retail Cost Cost Cost
Visual Studio Already owned by
Professional 2005 (7) Seapine $799.00 0.00 $0.00
Microsoft® SQL Server
Standard Edition 2005 Already owned by
(7) Seapine 1,849.00 0.00 0.00
Comparable
Server Machine machine already
DELL OptiPlex GX620 owned by
DT(2) Seapine $1,785 0.00 $0.00
Total Retail Cost $4,433.00
Total Seapine Cost $0.00
Total Student Cost $0.00

4.2 Timeline

Figure 6 — Actual Budget

The timeline shown in figure 7 on the next page is accurate as of the time of the

writing of this document. No major incidents occurred that would have changed the

timeline.

12




o |8 |Task Name Aug |Sep [Oct [Nov [Dec [Jan [Feb [Mar [Apr [May
1 | Research/Define problem 90 M w w1212 ' ' '
2 R Define Requirements/propose solution 9/?0 | 1%/12 l : : :
3 B Start researching code/technology needed | | l|1/30 F!:!I 12/2 | | |
42 R Create UML design diagrams. | 1127 e 12129 | |
5 | Implementing code | | 129 EEETEE 2/20 | |
6 B First Alpha version testing [ | I I | 2/20 @ 2/28 |
7 R Fix defects found in alpha version 7 | I I I I 131 g 3/9 I
s | Code for alpha version 2 b ' ' | 13/1 g™ 8/20 |
9 R Second Alpha version testing : l l l ! I 3%0 i]' a/28!
10 B Fix defects found on second alpha version : : : : : : £|’>/28 4/5:
11 | Final code implementation | | | | | P28 (@ 410
12 | First Beta Release and implement in sand box I I I I | | |49 4l
13 |l Beta Testing L | | | || 411 gmf 4/30
14 |H Write user documentation Lol I [ [ |1 49 [m]14/26
15 | Write final report and documentaion I I I I I I | 4/9 ] 14/26
16 |l Prepare final presentation b | | | I ani ey 4130
Figure 7 — Proposed Timeline
4.2.1 Fall Quarter Accomplishments
e Definition of the problem.
e Research of possible solutions.
e Solution identified.
e Proposal presentation made to faculty.
e Proposal document submitted.

4.2.2 Winter Quarter Accomplishments

Application and database design started.

Initial Implementation of code.
Deliverables defined.
User protocol defined.

Design protocol defined.

13



Design Freeze presentation made to faculty.

Design Freeze document submitted.

4.2.3 Spring Quarter Accomplishments

Continued and finalized implementation of code.
Continued testing of implemented code.

Help document finished.

Applications finished.

Presented project at Tech Expo.

Final presentation made to faculty.

Final project report submitted.

4.3 Software

The following lists the applications used in the development design and

deployment of the application in order of most importance:

Visual Studio 2005 — Application was programmed using C#. This
language was chosen because of its ease of use and familiarity the author
had with this language.

SQL Server 2005 Management Studio — Used to manage test databases.
Microsoft SQL server was chosen because of its availability under

Seapine’s current license.

14



e Surround SCM - Stored and managed the source code. Source Code
Management (SCM) software allows to version each change and makes it
easier to manage these changes.

e TestTrack Studio — Entered and tracked defects of applications and also
defined Test Cases and performed Test Runs.

e Microsoft Project 2000 — Created project timeline and timeline figure used
in this report.

e Microsoft Visio 2000 — Created UML diagrams used in presentations and

reports, including this one.

4.4 Hardware:
No special hardware is required for this project. There were already numerous
SQL 2005 servers installed on several machines. The user interface runs on any

workstation that was imaged by Seapine’s IT department.

5. Proof of Design

The following illustrates the different functionality offered by both applications.

5.1 Database Configuration
Both the RTS Admin and ReadyToShip applications need to connect to the RTS
Admin database on startup. The user or administrator can either connect to an existing

database or the application creates a new database.

15



The administrator does not need to first create the database in Microsoft SQL.
The application creates the database, ensuring consistency and also preventing any errors

caused by the administration creating the database incorrectly.

When either application starts, it looks for a configuration file to get the
connection information to the RTS Admin database. If it does not find the configuration
file, the configuration file has incorrect information, or if the application can not connect
with the information in the configuration file, the administrator is prompted to configure
the connection. This is accomplished by giving the user a window on which to enter the
configuration information. RTA Admin shows a different window than ReadyToShip.
The main difference is that the window displayed by RTS Admin also gives the
administrator the ability to tell the application to create a new database. Figure 8 below
shows the window that is displayed by RTS Admin to allow the administrator to

configure the database connection or to create a new one.

i =] |
SGL Server Connection
{ S0L Server | |
i Authentication
SOL Uszer Mamne I
SOL Password I
i Database Connection
¥ Cornect to Existing Database
" Create New Database
[Ereate [atabase |
Test Connection | Exit |

Figure 8 - Database Connection Configuration Window

16



The application allows the user to browse the network for available SQL servers
on the network. Figure 9 below shows the available SQL servers found on the Seapine

network using the window that is displayed by ReadyToShip.

i) Database Connection Wizard N ]

{SQL Server Connection

SOL Server Name

[ 1)
AUGUSTGE270
COATESGE270
DATAHOUND
FREDSEBS
JUDYDELL
LEAPTHIS
LOOPZE0
HISSOL

— Database Conhection MISZQLIES W
NUMBERS

QASOL
QAVSUPPORT
SELLERSGXZ70
TTPINTEGRATIONS

Test Connection | H Exit |

— Authentication

30L User Name

30L Password

Select Database

Figure 9 — Available SQL Servers in the Seapine Network

Once a server has been selected and valid credentials entered, the administrator is

able to browse databases in the specified SQL server. Figure 10, located on the next

page, displays the databases available in the selected Microsoft SQL Server.

17



f Database Connection Wizard = |EI|5|

SOL Server Conneclion
{ SOL Servar | lacal) |

i &uthentication

SOL User Name |:a

SOL Pasgword | xxxxxxxxxx

— Databage Connection

& Connect bo Existing Databaze

| .2
magter s

“ model —
mzdb
RTS_COMFIG
SCMO8db
SMFCE |
tempdb
T Tproject ¥

Test Conhection | Exit |

Figure 10 — Available Databases in the Specified SQL Server

Once the information has been entered, the application tests the validity of this

information and if it is valid, it saves it to the configuration file.

52 RTS ADMIN
RTS Admin provides the administrator two main functions. To create users that
use the ReadyToShip application and to set up the connectivity to the projects these users

use with the ReadyToShip application.

5.2.1 User Management

The administrator must create the users that use the ReadyToShip application. To
create a user, the administrator selects “Manage”>"Users” from the menu bar, or clicks
on the “Manage Users” button on the toolbar. Figure 11, located on the next page, shows

both options outlined.

18



i RTS Admin
File Manage Window Help
g = || €& Users

,_E Projects

[7 View Database Connection

Figure 11 — Manage User Menu Option and Toolbar Button

This displays the User List window, which displays any existing users. The

administrator can create, edit, view or delete a user from this window. Figure 12 below

displays the User List window.

o Add I 2 Edit | 4 view | x| Delete |

Fernando Project Adwinistrator

Figure 12 — User List Window

To create a new user, the administrator clicks on the “Add” button. This brings
up the “Add User” window. To add a user, only a user name and the role need to be

provided. It is not required to enter a password. Figure 13, located on the next page,

shows the “Add User” window.

19



T (o

User MName ||

Password I

Confirm Password I

Server Security
 Full Administrator
 Project Admin

# Regular User

i Add User | {] cancel |

Figure 13 — Add User Window

5.2.2 Project Management

The administrator must create the projects that the users use to track beta tester
communications. To create a project, the administrator selects “Manage”>"Projects”
from the menu bar or clicks on the “Manage Projects” button on the toolbar. Figure 14

below shows both options outlined.

¥ RTS Admin

File Manage Window Help

. g{.‘ Users

Ed] Projects

L; View Datsbase Connection

Figure 14 - Manage Projects menu and toolbar button

This displays the project list window. The administrator can add, edit, view or

delete a project from this window. Figure 15 below displays the project list window.

20



N .o
o1 Add | 7 Edit | 4 View 1| Delete |

Project
iD

Project Description

Project Nawe

Surround SCH 2008

Figure 15 - Project List Window

To create a new project, the administrator clicks on the “Add” button. This brings
up the “Add Project” window. To add a project, the administrator must provide three
different types of information. The “Add Project” window has three tabs, each tab for
each type of information. The first tab is the “General” tab. There, the user enters the
project name and the project description. Figure 16, located on the next page, displays

the “General” tab in the “Add Project” window.

21



T Il

General | Databasel Project Usersl

Project Name:

Project Description:

H idd Froject | E] Cancel |

Figure 16 - Add Project Window General Tab

The second type of information is the connection information to the SQL server
database for the project. The administrator must provide the SQL server, valid SQL
credentials and a name of the database to create in the SQL server. The SQL user
becomes the database owner because the database is created under this SQL user. Figure

17, located on the next page, displays the “Database” tab in the “Add Project” window.

22



i
General Database |Projec: Usersl
3QL Server I j
User Hame I
Pasaword I
Latabase I
= | Add {J cancel

Figure 17 - Add Project Window Database Tab

The third type of information is the user or users that have access to this project.

In most cases there is only one user associated with a project, since only one employee
manages the beta program for a product. Figure 18 below displays the “Project Users”

tab.

fndd Project k =10l
Generall Datsbase Froject Users |

Available Users Project Users

[administrator

Fernando
LLC
s

= Add 0 cancel

Figure 18 - Add Project Window Project Users Tab
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5.2.3 User Documentation

The administrator is able to access documentation to learn how to use the
application. To access the user documentation, the administrator selects “Help”>"RTS
Admin Help”. The help documentation in RTS Admin is a static web site. Figure 19

below shows the various sections available in the user documentation.

ZARTS Admin Help Pages - Microsoft Internet Explorer

File Edit Yiew Favortes Tools  Help

Qe - @ - ﬂ @ 7;‘, | /-Gearch :1\ Favorites &1“| i - 3

Address [&1 DTS AdminiRTS AdminibiniDebuglHelptindex. html FBs

RTS Admin Help Pages

Overview

Managing the Database

Managing Users

Managing Projects

Figure 19 - RTS Admin Help Topics

5.3 ReadyToShip
The ReadyToShip client application offers several functionalities to aid the user

with tracking beta tester communications.

5.3.1 Log-In Process
When ReadyToShip starts and finds a valid a valid connection to the RTS Admin
database, it displays the user window to enter a user name and password. Once the

information is entered, the user clicks on the “Get Projects” button to get a list of the
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projects that are available to this user. Figure 20, located below, displays the log in

window.

~=01]

—Authentication

User Name IFernandD

Password I-xxww'x-rxw

—Projects

Surround 3CM Z00S

Logn I | Cancel

Figure 20 - Log in Window

5.3.2 Tester Management
To manage beta testers, the user selects “View”>"Testers” from the menu bar or

clicks on the “View Testers” button. Figure 21 below show these options outlined.

i ReadyToship - Surround SCM 2008

Tools Help

Incidents

Figure 21 - View Testers toolbar button and menu option
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The tester list window appears. From this window, the user can select to add,

edit, view or delete a beta tester. Figure 22 below displays the Tester list window.

o Add 2 Edit |4 View Y| Delete
o] xJ

Tester Display
In Name

jdean jdeanfvert .com

E-Mail Address

fgrant fgrantfideosy.com
welder welderfifashonc.org

adyd dydlnfsoyn.edu

cremerf cremerfiseapine. com
fernandocremer fernandocremerfyahoo.com
cremerfc cremerfoefemail. us. edu

Joe

[ LU B N - U S

System

Support supportftechsupportforum. com

Figure 22 - Tester List Window

In the current structure of the beta program web site, most users are imported and
the “Add” button should be rarely used. When beta testers register for the beta program,
they only have to provide a “Display Name”, a password and an e-mail address.
ReadyToShip only imports the “Display Name” and the e-mail address only. To view
information about the tester, the user selects a tester and clicks on the “View” button.
This brings up the “View Tester” window. This window consists of two tabs, the first
one displaying the display name used in the user forum and the e-mail address provided
in the registration process. Figure 23, located here below, shows the “Detail” tab in the

“View Tester” window.

26



=

Detail= | F-mails |

Uzser Forum Display Name Ifgrant
E-mail Address Ifgrant@ideusy.cc\m
= Save ] cancel

Figure 23 - Details Tab in the View Tester Window

The second tab of the “View Tester” window is used to view the e-mails received
from this tester. The user can only view e-mails from this tab. To reply or forward any
e-mail from this window, the user selects “edit” from the Tester list window. The “E-
mails” tab in the “Edit User” window has the “reply” and “forward” buttons enabled.
Please refer to section 5.3.3 for more details on the e-mail functionality. Figure 24,

located on the next page, displays the “E-mail tab” of the “Edit Tester” window.
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=1

Ietails E-mails |

Email ID | Subject | Dats
Installer doesn't run on 64 bit =...

Jurround EBeta issue

Surround Eeta

View | Replwy | Forward |

e Save | {J cancel |

Figure 24 - E-mails Tab in the View Tester Window

5.3.3 Incident Management

ReadyToShip manages incidents. An incident is any contact a beta site user
makes. An e-mail, a phone call, a user forum post, feature request, defect report, all are
referred to as incidents. Incidents are associated with the beta site user. Each incident
has a source, which indicates the incidents’ origin (phone call, e-mail, user forum, etc...).
Incidents also have a status, which help the user manage the incidents. The user is able to

create incidents manually for those initiated through a phone call.

To manage incidents, the user uses the Incident list window. To access the
Incident list window, the user clicks on the “View”>"Incidents” option from the menu
bar or clicks on the “View Incidents” button on the toolbar. Figure 25, located on the

next page, displays both options outlined.
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ReadyToS Surround SCM 2008

Tools Help

Incidents

ﬂE Testers

Figure 25 — View Incident Menu Option and Toolbar Button

The Incident list window displays all of the incidents. On the upper right corner,
the window has a drop down menu with options to filter which incidents to display.

Figure 26 below displays the Incident list window.

& Incidents

&

Incident Display Filter

o Add 2 Edit | |4 View | w1 Delete | I{Select Filter Criterias

Incident
ID

| 4

I

Status ‘ Surmmar y

1 Test Bun 6: Login - User =

Z Hew Test Run 11: Login - User sees only projects that match their security settings for projects - User
3 MNew How do I add new words to my dictionary so that spell check will recognize them as spelled correctl
4 HNew Crash when exiting the program when the data should hawve been saved

5 HNew When accessing the database via the web, some of the characters do not display correctly

a6 New No warning message given when entering letters into a field that expected numerals

7 New Product D crashed as soon as I logged in

=] New It would ke nice if I could duplicate security groups and manually select a new name for them

=] Hewr Iz there a way to =2elect all defects in the list wview at the =Same time?

10 Mew Source code integration does not work with wversion 2

11 HNew Crash when importing defects from wversion 1 to wersion 2

1z New Crash when exporting records from an imported datsbase

13 New It would be nice if Product & had an integrated weather feature

14 In Progress Sample Project for version 2 does not get installed

15 Hew Times Wew Roman should be the default font for Product A

la Hew Times Wew Roman should be the default font for Product B -
17 Hew Times New Roman should be the default font for Product B

15 New Times New Roman should be the default font for Product C

19 New New Private Message at Tech Support Forum -

-

| »

Tocal Ttems: 22

Figure 26 - Incident List Window
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On the upper right hand corner the user can use the Incident Display Filter to filter
the Incidents that are displayed. The user clicks on the drop down menu and is given five
options that the user can filter the display by. Figure 27 below displays the filter options

given to the user.

=10l x|

Incident Display Filter

<aelect Filter Criteriarx

<5elect Filter Criteriax
£1]1 Incidents -
3tatus
Jource

Tester
Jearch Incident Description..
ity = =

cognize them as spelled correctl

tiht Ad=wnlasr ~carrvrect Tor

Figure 27 - Incident Display Filter Options

The first option displays all of the incidents in the project that user is logged into.
The remaining options display a second window from which to further filter the display
of incidents. Options two through four display a window with a drop down menu. For
example, if the user selects the “Tester” option, the second window displays a drop down
menu with a list of all the testers. The user selects a tester to only have displayed the
Incidents reported by the selected tester. The last option displays a window with a text
box to enter a string to search the incident description and only display those incidents

whose description matches this string.
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On the bottom right corner displays a total of all incidents displayed. This adds
power to the filter options. In the example in the paragraph above, not only can the user
filter the display of incidents by a tester, the user can also see a total of the incidents

reported by this tester.

In the current beta program structure, more incidents are imported by other
events. However, since a beta tester may still contact Seapine by phone, the “Add”

button gives the user the ability to also track those communications.

The user can add, edit view or delete any incident by selecting the appropriate
button at the top of the incident list window. All these buttons except for the delete
window displays the Incident detail window. Depending on the button selected, the “Add
Incident”, “Edit Incident” or “View Incident” detail window displays. Figure 28, located

next page, displays the “Edit Incident” detail window.
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JCcumae: -l

[ Swmmar y

ITest FEun &: Login - User sees only projects that match their security settings for projects - The login scree
. Dhetails
Tester Incident Source ITestTrack |
Date Created IQ.-"'?.-"ZDDG 7:45:13 FM Status INEW j
Wersion I
Description |E—mails| History
This defect was created via test run #6 - Login - User sees only projects that match their security settings
for projects.
The following problems were reported:
1. The login screen was empty
Enter Signature |
‘ el Save 3 ciose

Figure 28 — Incident Detail Window

The Incident detail window consists of an upper and lower section. The upper
section of the window contains fields with details about this incident. It contains the
tester that reported the incident, a text field to enter the beta release version involved in
the incident, the date when the incident is reported, the source of the incident and finally,
the status of the incident. The status is used by the user to better manage the Incidents by
being able to identify which incidents need the user’s attention. There are four status
options for incidents. Figure 29, located on the next page, displays the status options

displayed in the “Status” drop down menu.
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Status

In Progress
Waiting on tester
Closed

‘ojects that match their security settings

Figure 29 - Status Options

The lower section of the Incident detail window consists of three tabs. First is the
“Description” tab, which contains a rich text box for a more detailed description of the
incident. The tab also contains the “Enter Signature” button, which appends the
description with the current system time and date, as well as the currently logged in user.
Figure 30 below displays the signature button and how the signature is displayed

outlined.

DESCripEiDnlE—mails Histaryl

HSHZTHZDD? 11:34:50 PM~Fernando |

Thiz defect was created via test run 6 - Lo
for projects.

The following problems were reported:
1. The login sScreen was ewpty

| Enter Signature I

Figure 30 — Enter Signature Button and Sample Signature
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The second tab is for tracking e-mails specific to this incident. This tab shows the
e-mails received and sent related to this incident. The user can only reply, forward or
send an e-mail related to this incident if the user edits the incident. Please refer to section

5.3.3 for more details on the e-mail functionality. Figure 31 below shows the e-mail tab.

Description E-mails |Hist0ry

[ Sent

Email ID | subiect Ta Date

INC[19] : Installer doesn't run on... fernandocremerfyahoo.com 107 12:10:37 PM

— Received

Ewail ID | Subject | From | pate

New Priwvat

Installer doesn't run on 64 hit =... fernandocremerfyahoo.com 5/19/2007 10:17:24 PN

View E-mail | Beply To E-mail I Forward E-mail | Send E-mail | Manage E-mails

H Save | ﬂ Close |

Figure 31 — E-mails Tab on the Incident Detail Window

The third and last tab is for viewing the history of the specified incident. Every
event that somehow modifies the incident is recorded. From a change in the status to an
e-mail being replied to, all events are recorded. Figure 32, located on the next page,

displays the “History” tab.

34



Description| E-mails History

Ewent Type Event Description Event Date Event User
Add New Incident Added.O3wmary: New ... |5/24/2007 7:42:03 FPH Fernando
Editc E-mzil Linked to Incident.OE-mwail... [5/24/2007 7:42:08 PM Fernando
Editc An E-mzail was sent.The E-mail sen... [5/28/2007 12:10:37 PM Fernando

Incident Edited.O3tatus changed £... |5 07 12:19:41 PH Fernando

— Event Details

Event Type: IEdit Event Date 5/28/2007 12:19:41 P

Event User: IFernando

Incident Edited.
Status changed from: In Progress to Waiting on tester.

H Save | El Close

Figure 32 — History Tab on the Incident Detail Window Figure

5.3.4 E-mail Management and Tracking
There are several aspects to the e-mail functionality provided in the ReadyToShip
application. ReadyToShip imports e-mails from a specified POP3 e-mail account, sends

e-mails through a specified SMTP server, and tracks the e-mails through various options.

Before e-mails can be managed, the e-mail configuration must be set. The e-mail
configuration includes the POP3 account settings as well as the SMTP server to send the
e-mails through. To set these settings, the user selects “Tools”>"Options”>"E-mails”

from the menu bar or selects the “Manage E-mails” button on the toolbar.

The manage e-mails window appears. From this window the user can get e-mails

from the POP3 account, filter the view of e-mails, search the e-mails, view an e-mail,

reply to an e-mail, forward an e-mail, create an incident from an e-mail, link an e-mail to
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an existing incident and delete any e-mail. Figure 33 below displays the “Manage E-

mails” window.

& Manage E-mails

I dearch E-mails I

Email ID Subject | From

1 New Private Message at Tech Suppo... "Tech Support Forum" <supportftec... 5/
2 TechSupportForwn. comwm Welcomes vou "Tech Support Forum™ <supportltec...
3 Installer doesn't run on 64 bit s... "Fernando Cremer” <fernandocremer...
4 Eeta Program - issue with installer "Fernando Cremer” <cremerfclemsail...
5 BEta Program - Issue with Install... "Fernando Cremer” <cremerfcfemail...
] Surround Beta issue "Fernando Cremer"” <fernandocremer...
7 Surround EBeta "Fernando Cremer" <fernandocremer...
] Tnable to create baseline branch "Fernando Cremer™ <cremerf@seapin...
10 Can not wiew branch properties "Fernando Cremer” <cremerffiseapin...

Forward E-mail Reply to E-mail Send E-mail

View E-mail

2 Get E-mails |

Create Incident |
Link To Incident |

x’_] Delete |

Figure 33 — Manage E-mails Window

a Close |

When E-mails are imported, ReadyToShip reads the e-mails from the POP3

account and copies the e-mail information to its database. The e-mail Unique Identifier

(UID) is saved on a separate table for each e-mail imported. When an e-mail is deleted

from the Manage E-mails window, it is only deleted from the ReadyToShip database not

the POP3 account. The corresponding record on the table that contains the UID, however

is not deleted. This is because when ReadyToShip imports e-mails, it first checks the e-

mail UID for every e-mail already imported. This prevents re-importing old e-mails.

When an incident is created from an e-mail, the incident’s source is set to “E-

mail” and the incident status is set to “new”. The add history event associated with the

36




incident documents the e-mail that created it. Also, ReadyToShip uses the e-mail address
that sent the e-mail and searches the tester table for a match. If it finds a match,
ReadyToShip associates the incident with this tester. If it does not find a match,
ReadyToShip creates a new tester entry. It strips the domain portion of the e-mail
address (everything starting from the “@”") and uses that as the Display Name.

When an e-mail is linked to an existing incident, an edit history event is recorded and it

documents the e-mail.

The “Manage E-mails” window provides some filter options to limit the display

of the e-mails shown. Figure 34 below displays the available filter options.

& Manage E-mails

I Jearch E-mails | j

Received
Ewail ID Subject | Frosent

New Private Message at Tech Suppo... "Te[RERLOERR= e duisl_ s

Not Linked with Incident

Jent & Linked With Incident

Installer doesn't run on 64 hit =... "Fe|Sent & Not Linked With Incident .@ Get

"Fe RPeceived & Linked With Incident
Received & Not Linked With Incident

EEta Program - Issue with Install... MFelfliandd i =T o =) 7= i o L=

TechSupportForwn. oot Teloomwes you "Te

Eeta Program - issue with installer

1
2
3
4
5

I

Figure 34 — Filter Options in the Manage E-mails Window

With the use of these filters, the user is able differentiate those e-mails that have
been sent versus those received, linked with incident versus those that are not, as well as
other combinations. The “Search E-mails” button searches all the e-mails for the
specified string entered in the text box next to the button. It searches the e-mail subject,

body and e-mail address.
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5.3.5 TestTrack Import:

ReadyToShip imports the records from the TestTrack project database. The user

must first set the connection settings to be able to retrieve the records from the TestTrack

database. To enter these settings, the user selects the “Tools”>"Options”>"TestTrack”.

This opens the window where the user enters the connection information. The window

provides a drop down menu that allows browsing the network for available SQL servers.

Figure 35 below illustrates the dropdown menu with the available SQL servers in the

Seapine network.

SOL Server Mame

hentication

30L User Neme

0L Password

abase Connection

Select Database

[lozal)
AUGUITGHEZ?0
COATESGHZ?O
DATAHOUND
FEEDSES
JUDYDELL
LEAPTHIS
LOOPzZ80
MISSOL
HIS3OLZKS
NUMEERS
QAZCL
QATSUPPORT
SELLERIGEZ?0
TTPINTEGRATIONS

Figure 35 — SQL Server in the Seapine Network

The user login used to connect must have permissions to be able to browse the

database tables and retrieve the records. Figure 36, located on the next page, illustrates

the TestTrack Import Options window.

38



i TestTrack Connection o ] 1
S0L Server I(local]| j
User Name Isa
Password In-wwwn-n-wwwwa-

SQL Datakase ITTprDject. j
Project Name |seup1eBerae ~|
Zave | Cancel |

Figure 36 — TestTrack Import Options Window

To import the records from the TestTrack Database the user selects the
“Tools”>"Import From TestTrack” from the menu bar or clicks on the “Import From

TestTrack” button from the toolbar. Figure 37 below displays the options outlined.

File View Tools Help

et MNew Testers

Import From TestTrack

Options k

a
&
Manhage E-wails
P
i

Zend E-mail

Feports

Cloze All Windows

e @

Figure 37 - Import From TestTrack Menu Option and Toolbar Button
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When ReadyToShip imports records from the TestTrack project database, it reads
the records that it needs and copies them to the table where the incidents are stored. The
incident’s source is set to “TestTrack” and the incident’s status is set to “New”.
ReadyToShip also looks at the user record in the TestTrack database and it looks at the
tester table in the ReadyToShip project database. If it finds the tester, it associates the
incident with that tester. If it doesn’t find the tester, it adds the tester to the ReadyToShip

project database and associates the incident with the tester.

ReadyToShip also saves the last imported record ID from the TestTrack database.
The record ID is a number that increments each time a record is added in TestTrack, so
ReadyToShip only needs to know the ID of the last imported record, since that is the
greatest number at that time. Next time the user imports from the TestTrack project
database, it only looks for those records with a record ID greater than the one saved in the

ReadyToShip project database. This prevents old records from being imported again.

ReadyToShip displays a window with a progress bar and a label to displays
messages to the user. If records are imported, the label displays the total number of
imported defects, if no new records are found, the label displays a message stating so, and
if an error occurs, the label displays the error. Figure 38, located on the next page,

displays the TestTrack Import status window.
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ReadyToShip

Importing of Defects Finished
17 BEecords Imported

Close

Figure 38 - Import From TestTrack Progress Window

5.3.6 Simple Machine Forum Import

ReadyToShip imports records from the Simple Machine Forum (SMF) database.
The user must first set the connection settings to this database. To set these options, the
user selects “Tools”>"Options”>"Simple Machine Forum”. The user must provide the

host name of the MySQL database, valid credentials, and the database name.

To import the records, the user selects “Tools”>"Get New Testers” option from
the menu bar or clicks on the “Get New Tester” button on the toolbar. The “memberID”,
which is the associated ID of the tester in the SMF database, is also imported. When
ReadyToShip imports the records from the SMF database, it checks the “memberID” and
only imports those that do not match any “memberID” stored in the ReadyToShip

database.
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5.3.7 Reports
ReadyToShip provides reports to give the user the ability to get some metrics on
the data in the ReadyToShip project. To run a report, the user selects “Tools”>"Reports”

from the menu bar or clicks on the “Reports” button on the toolbar.

The Reports window displays with a dropdown menu and a label that tells the
user that depending on the size of the ReadyToShip project database, the application may
appear to hang while the report is generated. The drop down menu has all of the report
options that ReadyToShip offers. Figure 39 below displays the report options that

ReadyToShip offers.

—iBix]

Jelect the report type to run:

Note: Depending on the size of the
database, it may take some Cime to generate
the report, the application may appear to
hang

[

Incidents
Testers
Incidents Grouped By Testers

Incidents Grouped By 3tatus
Incidents Grouped By Jource

Figure 39 — Report Options

Reports in ReadyToShip are in HTML format. ReadyToShip dynamically creates
the HTML page when the report is generated. The style used in the HTML pages is very
minimal. The first two report options display the entire records and it gives a total at the

bottom of the report. The remaining three options display the subtotal for each grouping
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and also displays to total of all the records. Figures 40 (below) and 41 (located on the

next page) display the “Incidents Grouped By Testers” report.

7} Incident Report - Microsoft Internet Explorer

a [:\ReadyToShip\Ready Tashipibin\ D ebugh IncidentBy TesterReport. html

ReadyToShip Reports

Incidents Grouped by Testers

Total Incidents Reported By jdean:

Total Incidents Reported By fgrant: 0

Total Incidents Reported By welder: 1

él I I

Figure 40 — Incident Grouped By Tester Report (Top)
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/3 Incident Report - Microsoft Internet Explorer (&)

File Edit Wiew Favorites Tools Help | :,'

) Btk - d - d @ ;\] | /..-jSearch \j"\'\/ Favorites {:‘} | = u__,_ e _] :‘i

fddress |@ [:\ReadyToShip\Ready Toshipibini Debug\IncidentBy TesterReport. bt = Go |Links »
|39 zlefaul: }ont forul?roduc;:l Chu |New |Joe |TestTrack Eé;!ES ;M ‘ d

Total Incidents Reported By Joe: 10

Incident Summary ‘Status Display Source Version Date Reported
ID Hame
o R e Ewm chovid bty sysen  mestmmack 14320,
B e Tt " Wew systen  mesemmaox  7WA000
Total Incidents Reported By System: 2
igcident ‘Summary Status ﬁi]snzlay Source Version Date Reported
el = S ST
o phewremtmommcon e upere pman 2R/,
Total Incidents Reported By suppeort: 2
Total Incidents: 39
[&] pore l_ l_ l_ l_ |_| ¢ My Computer

Figure 41 — Incident Grouped By Tester Report (Bottom)

5.3.8  User Documentation
The user can access documentation to learn how to use the application. To access
the user documentation, the user selects “Help”>""ReadyToShip” option from the menu

bar, or clicks on the “ReadyToShip” button on the toolbar.

The documentation is presented as a static web site that consists of various HTML

files. The user can use the browser features to search, print and export the user
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documentation. The first help page shown is the index page which shows the various

help topics available. Figure 42 below displays the index page.

3§ R acly TS Hedga Pages - Microsofl Inberred Explares

Ble L Yew Fgerbes Took bk

LIE
I‘.'
I - Q- [ Q] Pwws e @3- L BB
Acress [8] 0iie D ] = Bl s *
ReadyToShip Help Pages
Import om TestTrack
Import From Simple Machine Forum
Database Reqguirements
[Eows

3 My Conpures

Figure 42 — ReadyToShip Index Page

From the index page, the user is able to select any category to view. Once the
user is on that page, there is a link at the top and bottom of the page that the user can

click on to return to the index page. Figure 43, located on the next page, displays the top

of the “Managing Incidents” page.
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6.

6.1

provides an easy to use interface and it requires minimal configuration. The project

=18] x|

A ReadyToShip - Managing Incidents - Microsoft Internet Explorer

Fle  Edit

Wiew Favorites  Took  Help

‘ o

\L') - |ﬂ @ kh | ;3 scarch \:}(Favur\tes -€‘}| [_.:;v :\? - J 3

= B eo ‘Llnks B

(P sack - |

Address I@ D\ReadyToShipiReadyToShiptbiniDebugihelptIncidents. html

4

Back To Menu

ReadyToShip - Managing Incidents

Viewing Incidents

To view the list of existing incidents, select "View">»"Incidents"”

& ReadyToShip - BetasiteProject

View | Tools Help

File
ac

¢ Testers

"View Incidents™ button on the toolbar.

il ReadyToShip - BetaSiteProject

File View Tools Help
£ 846060

View Incidents

or click on the

@ Done

Figure 43 — Incident Help Page

Conclusion and Recommendations

Conclusion

ReadyToShip solves the problem posed by the current Beta Program structure. It

-

| o
A B =

allowed the author to create a complete, sophisticated program for the first time. The

project also allowed him to experience the complete software development.

The ReadyToShip application and documentation will be given to Seapine for

optional use in the management of future Beta Programs. The source code will be placed

in the Seapine’s Source Code Management solution.
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6.2  Recommendations
The version of ReadyToShip in this document is 1.0, the very first release.
Since the source code will be available on the Seapine Source Control server, Seapine

employees may add features as they see the need.

There are several improvements that the author plans to make within the next
year. Tentatively, these features would be available in version 2.0 of the application.
Some of the features that may be added may include but are not limited to the ability to
create custom filters, the ability to create custom reports, a stronger search feature,
integration with Seapine’s Active Directory Server and the concept of user settings to

customize the application.
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